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Summary


The key to successful project management is effective communication (within the project team, across functions and up the management chain) of critical project information, status and changes.  An effective organizational project management solution should meet the following criteria:


Make communication on projects within the organization easier and more effective.


Provide an open platform for extension and customization to company standards.


Contain a robust scheduling engine that fit users’ needs.


Be accessible to members of the project team.


The rest of this document will compare Microsoft Project for Windows 95 and SureTrak 1.0 using this set of criteria for effective organizational project management solutions.  Additionally, we will examine each of these products on other dimensions including category leadership, cross-platform support, product “family” availability, and training and support.


Make Communication on Projects Within the Organization Easier and More Effective.


Solid, clear communication is critical  to the success of any project.  Project management software should provide planners with the tools they need to keep everyone informed about assignments, deadlines, changes and overall project status. Since few people plan and execute projects alone,  the trend in project management software is to complement project reporting tools by including communications capabilities that allow  team members to collaborate on the project management process itself.   The increasing prevalence of networks and electronic mail provides an exciting new platform that can be leveraged by project management packages to address the critical communication dimension of project management.  This is one of the most exciting opportunities in the project management category.


Microsoft Project for Windows 95


Reporting


Microsoft Project ships with an entire gallery of common project reports.  You can easily create any of these pre-defined reports with the simple click of your mouse, or you can create your own custom reports by selecting the tasks and fields you want to include.  Ready-made reports that ship with Microsoft Project are offered in the following categories:  Project Overviews, Current Activities, Costs, Assignments, and Workload.


Additionally, all of the Microsoft Project Views (including the Gantt Chart, Monthly Calendar, PERT Chart, Task Sheet, Resource Views, etc.) can be used to report project information.  Simply select Print from your File menu, and what you see on your screen will be sent directly to your printer.


Multi-Project


Microsoft Project has a built-in multi-project consolidation feature which enables you to open and merge together up to 80 projects at once - including all the details from all the projects.  This makes it very easy for team members to identify what others expect of them, for group managers to assess upcoming resource needs, for project managers to stay abreast of other projects that are competing for resources, and for executives to keep on top of the big picture.


Additionally, Microsoft Project for Windows 95 has been designed to integrate seamlessly with Microsoft Exchange Server for communicating multi-project information across the enterprise.  With the “Post to Exchange” feature, Microsoft Project publishes selected details about your project plans into a  Microsoft Exchange folder.  Microsoft Exchange folders can hold many different project files, and allow viewers across the organization to get project status without having to open each and every project file.   Microsoft Exchange users can even define special “views” of the folder to see and compare a variety of project data types across all files that are in the folder.  So, for example, you could sort projects by Finish Date, or by Manager, or by Department to get the big picture in a way that makes sense to you.


Workgroup Features


Microsoft Project was the first project management software to take advantage of electronic mail to automate common workgroup scenarios.  In Microsoft Project for Windows 95, the following workgroup capabilities are available:


Routing of project plans via MAPI or VIM compliant mail systems.


TeamAssign allows project managers to delegate tasks via electronic mail.


TeamUpdate sends email updates to notify resources of changes in the plan.


Integration with Microsoft Schedule+ allows resources to track their task progress directly in their electronic To Do list.


TeamStatus enables resources to send email status reports that are automatically incorporated into Microsoft Project files.


SureTrak 1.0 for Windows 


Reporting


SureTrak 1.0 does not support reporting in a similar way to Microsoft Project.  Instead of a report gallery and predefined reports, SureTrak allows the user to print any view of the project they have currently displayed.  In addition the Reports menu stores views to print at a later time.  SureTrak does supply many pre-made reports in their report menu.


While this may seem adequate for many report scenarios it falls short when a user wants to print non-Gantt related information.  For example it is very difficult to create a view that shows the hours a resource is working on a task. (The Who Does What When Report in Microsoft Project)  You can display the task and a bar but not more detailed information like hours.  


In addition SureTrak 1.0 fails to address a base need of project reporting.  There is no PERT chart built into the product.  There is no way to see just the tasks and relationships which is fundamental to most project managers.  One of SureTrak’s reports is a Time Scaled Logic but it assumes the user always wants to see the layout across time which is not what a PERT chart was designed to do.  PERT charts allow project managers to see large amounts of tasks and dependencies easily.  


Multi Project support


SureTrak 1.0 assumes that their users are always working on one project.  This is most apparent by their lack of support for project consolidation.  Using their native file format there is no way to combine projects to see resource usage, task dependencies or even cross project reporting.  


Combining projects works well for project managers but many people who are not project managers need to access this information.  Microsoft Project includes this scenario through support of Microsoft Exchange server.  SureTrak 1.0 only integrates with its $5,000 companion product, P3.   


�
Workgroup Features


SureTrak 1.0 has done a fair job copying the workgroup features of Microsoft Project.  Their “Send in Mail” command mimics many of the benefits of the TeamAssign and TeamUpdate features in Microsoft Project.  Unfortunately SureTrak 1.0 provides the features with no security required to ensure data integrity, nor any of the automation.  For example, in Microsoft Project the mail messages are separated between resources and sent automatically.  In addition you can determine which fields are sent to the resource and whether the resource can modify the field.  


In SureTrak 1.0 all task details are sent in one mail message. The Project Manager needs to figure out who the resources are to address the mail message.  In addition the messages are merely text, so the resource can even change the name of the task without the project manager's permission. If a resource accidentally deletes some important information, SureTrak can no longer read the message.  This is not possible in Microsoft Project.


Also SureTrak 1.0 has missed the most significant Workgroup feature; integration with Schedule Plus.  In Microsoft Project a resource can actually track their work in Schedule Plus and update the information to the project manager automatically.  In SureTrak 1.0 the resource must re-enter any information they have kept in the ASCII mail message sent by SureTrak 1.0. 


Provide an Open Platform for Extension and Customization to Company Standards.


As project management software has become a more common desktop tool, an increasing number of businesses are starting to incorporate it as a component of their mission-critical business solutions.  Project management software should be open and accessible so that the data from project plans can be integrated with other business systems, such as timesheets, cost accounting systems, and other specializing project management applications. Additionally, project planning software should be fully customizable to meet corporate standards that vary widely from company to company. 


Microsoft Project for Windows 95


Customizable Interface


Virtually every component of the Microsoft Project interface is customizable.  The toolbars are fully customizable: you can rearrange buttons within or among toolbars; you can change the function of individual buttons; you can change the look of buttons with the Button Editor;  you can even create a whole new toolbar just as you like it!


The menus in Microsoft Project are completely customizable as well.  You can assign a macro or command to a menu item on any menu, or submenu, that you choose to create.  You can even remove commands from menus to simplify the interface for new users.  As they learn and grow with the product, you can add commands and features as users feel ready to try them.


In addition to providing tools for customizing the way the software itself looks, Microsoft Project gives you complete control over the appearance of information on your screen.  Tables allow you to define the types of project information to display, while filters screen for certain tasks or resources based on criteria you define.  You can combine tables and filters into custom Views, which you can further personalize by changing the color and style of text, graphics, and gridlines.


Visual Basic® for Applications and OLE Support


Microsoft Project ships with the tools you need to incorporate project planning software into custom solutions to meet your business needs.  Microsoft Project includes Visual Basic for Applications (VBA) - a special, hostable edition of Visual Basic, the industry’s most popular programming environment for Windows.  Visual Basic for Applications offers:  


A  programming environment in Microsoft Project that is consistent with Microsoft Visual Basic, Microsoft Excel, and other Microsoft applications that support Visual Basic for Applications.


An object-oriented data access method that makes it substantially easier to refer to Microsoft Project schedule information, whether you are writing code inside Microsoft Project or in another programming environment.


Fluid data communication that makes it easy to get at Microsoft Project data from outside Microsoft Project.


A robust debugging system. 


A macro recorder that enables anyone to automate common activities - turn on the macro recorder to record the steps you want Microsoft Project to memorize, and you can then play them back at any time you want to complete that set of tasks!


Additionally, Microsoft Project exposes all project data (projects, tasks, resources, assignments, calendars) as objects through OLE Automation.  This makes it possible for other applications and tools to drive Microsoft Project directly from their macro language.  For example Microsoft Excel is capable of using Microsoft Project to calculate schedules through OLE Automation.


ODBC


Microsoft Project for Windows 95 provides powerful database connectivity via ODBC.  With Save to Database and Open from Database commands, users can save their Microsoft Project files directly to any corporate databases that are ODBC-compliant.  This capability can also be built into a company-wide solution, as these commands are accessible programmatically via Visual Basic for Applications.


SureTrak 1.0 for Windows 


 Customizable Interface


SureTrak 1.0 allows a user to customize Toolbars assigning any predefined command to a button.  Unlike Microsoft Project the user cannot determine what icon will represent each command.  Also individual macros cannot be assigned different icons.  Only the “Basic Scripts” command can be assigned to an icon. Because of this an administrator cannot add “features” written in the macro language and make them transparent to the user.


Menus are even less customizable than toolbars in SureTrak 1.0. The Tools menu is created based on INI sections in the SureTrak INI file.  These menu items can then point to individual macros.  Many companies using Microsoft Project modify the menu structure to reflect company standards.  Specific layouts are added to the View menu; different names are given for the PERT view, even top level menu names can be changed.  SureTrak 1.0 cannot modify the menus beyond the Tools menu.


Macro Support


SureTrak 1.0 includes an external macro language created by another company.  This Language, SoftBridge Basic, is designed to create files that act upon another product.  This implementation leaves a lot to be desired.  Because these macros are files, they must always be available in a specific location.  A novice user could easily delete them and lose that functionality.  Additionally users cannot simply record a series of actions as a macro. All macros must be written from scratch in the macro language by someone with an extensive knowledge in SoftBridge Basic. 


SureTrak’s version of Basic is not identical with Visual Basic, the market leader.  All Visual Basic programmers must re-learn this variant of Basic.


Database connectivity


SureTrak 1.0 relies on P3 for database connectivity.  Where Microsoft Project provides direct access from a menu or toolbar, SureTrak 1.0 requires the user to export the file to P3.  Once the file is in P3 file format other ODBC compliant applications can extract data.  Unfortunately there is no easy way to put the information into any other ODBC database.  For example Microsoft Project allows direct storage in SQL Server, or Oracle databases.  The only way to move the SureTrak data into SQL Server is by hand.


Contain a Robust Scheduling Engine that Fits Users’ Needs


In the long history of project management software, the scheduling engine has traditionally been the sole focus of software evaluations.  It remains a critical component of an evaluation, but has become part of a “bigger picture” as the project management software market has matured.  Evaluators now examine the scheduling engine from a real world perspective - real world users demand a robust scheduling engine that works for the software user and is part of a total software solution that easily fits into their organization.


Microsoft Project for Windows 95


Outlining


The outlining features of Microsoft Project make it easy and fast to organize your project plans.  With straightforward drag-and-drop technology, you can enter and organize your tasks and milestones, reorganize your task list, or collapse and expand your task list to see different levels of detail.   With Microsoft Project you can create up to 10 indented levels of tasks in one project file’s task list, and outline structure is stored in the “Outline Number” field for filtering and reporting.


Calendars


Microsoft Project uses calendars to define the working and nonworking days and hours for the project. The project calendar indicates regular working hours and standard nonworking days, such as weekends.  This calendar is completely customizable.  If a group of resources shares basic schedule information that is different from the project calendar, you can create a different base calendar for them.  Additionally, Microsoft Project provides a resource calendar, which designates unique information in a resource’s schedule, such as vacations, special working hours, and other time away from the project.  When you assign a resource to a task, Microsoft Project automatically calculates the project schedule by referring to the project, base, and resource calendars in your plan.  All of these calendars are completely customizable, and are easy to change in the familiar monthly-calendar format of the “Change Working Time” dialog box.


Relationships and Constraints


Microsoft Project for Windows 95 provides an arsenal of relationship types and constraints for planners to use in constucting their project schedules.  Relationships (or “links” ) are easy to establish by simply dragging and dropping between task bars in the Gantt, Calendar, or PERT chart views - they are graphically represented by arrows between tasks so it’s easy to see the flow of your plan.  To change a relationship type, all you need to do is double-click on the link arrow, and select the new dependency type.  You can further refine task relationships by adding “lead” and “lag” time which build overlap or delays between the tasks in your plan.


If some tasks in your plan must be performed at certain times, you can also use constraints to set a start or finish date for a task.  Microsoft Project supports the following types of constraints:  As soon as possible; As late as possible, Must start on; Must finish on; Start no later than; Finish no later than; Start no earlier than; Finish no earlier than.








Baselines


A baseline plan provides a basis for the comparison of costs, work, and scheduled dates as you track the progress of your project.  By comparing the information in your baseline plan to current information, you can monitor the progress of your project to ensure that tasks are on schedule, resources are completing their work in the time allocated, and costs are not exceeding your budget.  Microsoft Project provides the capability to store up to 5 baselines for your project, so you can keep track of multiple versions of your schedule as your project progresses. 


SureTrak 1.0 for Windows


Outlining


SureTrak 1.0 excels in organizing project data.  There are many different things you can outline and group.  Tasks can be grouped and displayed by priority, areas, responsibility etc. The drawback is that it can be cumbersome to do basic outlining.  To simply indent a few tasks you need to first be in outlining “mode” by going into the Organize dialog in the Format menu and select Outline.  Then the icons on the Editing toolbar (not on by default) are accessible to indent like in Microsoft Project.  No dragging and dropping is available.


Calendars


SureTrak 1.0 supports all of the calendar capabilities of Microsoft Project.  In addition they have task calendars and an annual feature that lets a project manager set January 1st as a holiday no matter when it falls.


Relationships and Constraints


Surprisingly SureTrak 1.0 does not support all of the relationships that Microsoft Project supports.  Both have Start to Start, Finish to Start and Finish to Finish but only Microsoft Project supports Start to Finish.  SureTrak does have the concept of Early and Late constraints which allows a project manager to say that a task cannot start before “X” date and cannot finish after “Y” date.


Another ease of use problem with SureTrak 1.0 is drawing relationships.   Once the SureTrak 1.0 user is in Relationships “mode” they can draw relationships on the Gantt chart.  Unfortunately there is no visual indicator that the user is in Relationships “mode”.  This problem is significant enough to warrant the SureTrak product support group to write a document on how to draw relationships in SureTrak 1.0.


Baselines


SureTrak 1.0 only supports one baseline for a project.  So you cannot take multiple “snapshots” of your project and compare them.


Be Accessible to All Members of the Project Team


As the project management category rapidly expands,  many purchasers are first-time users of  project management software.  These users are people who want to get up and running with their plans without having to invest large amounts of time up front simply learning the software.   It is also important that as users grow in their experience, that their software be able to grow with them.  Basic functionality should be easy to access, but sophisticated project management capabilities should also be available.


Microsoft Project for Windows 95


Usability testing


Microsoft has invested hundreds of hours in usability testing Microsoft Project.  Most features and dialog boxes have undergone extensive testing and redesign.  For example our Task Information dialog in Microsoft Project 3.0 was very confusing to users.  Through many usabilty tests we accomplished a design that hid the complex information from new users while still providing the advanced features for experienced users. In another example we watch many new users pick up tasks and move them close together.  They were simulating the look of a Gantt chart without creating any links in their tasks.  Examples like this led us to create the PlanningWizard. (See below)  Most of the advances the we have received from usabilty testing are seemingly small; but put together they make Microsoft Project the most usable project management package in the world.  In fact, in a recent review of project management software in  NSTL’s Software Digest, Microsoft Project 4.0 rates tops in overall usability when compared to three other leading products.�


Consistency with the Microsoft Office


Microsoft Project has been designed as a member of the Microsoft Office family of desktop productivity applications.  As such, all of our top-level menus are consistent with the other Microsoft Office applications, and toolbar buttons for common activities look identical, share common ToolTips,  and are placed in the same location in each program. Frequently-used dialogs (such as File Open) and the Help system are also identical across all of the Microsoft Office applications.  Additionally, implementations of  Microsoft Project-specific features have been designed to look and feel like other Office-family features with tabbed dialogs, screen tips, and right-mouse click functionality. Since so many users are now making Microsoft Project one of their standard desktop tools, we thought it was important to look and work like their other software programs such as Microsoft Word and Microsoft Excel.  Life is too short, and most people are too busy to learn a new software package for every type of task they are trying to accomplish.  If you are familiar with Microsoft Word or Microsoft Excel, you will already know over 100 Microsoft Project features!


PlanningWizard


The PlanningWizard in Microsoft Project is an example of IntelliSense™ technology - features which sense what the user is trying to accomplish and intelligently produce the desired result, making complex tasks simple and routine tasks automatic.  The PlanningWizard is especially helpful for new users who may not fully realize the implications of their actions as they drag and drop Gantt bars around to set up their schedule.  The PlanningWizard monitors your actions as you work and appears automatically when needed.  There are scores of situations in which the PlanningWizard can help you: establishing links, changing working/non-working time, and streamlining your data entry process to name a few.


User Assistance


Microsoft Project for Windows 95 features new natural language technology which gives you the help you need when you need it.  Just like the rest of the Microsoft Office family applications, virtually all documentation on Microsoft Project is built right into Online Help, and the AnswerWizard is the single, intelligent entry point into all user assistance.  Users type questions into the AnswerWizard, and are directed to the most appropriate form of assistance.  Users formulate requests for assistance in their own language, rather than according to an application’s lexicon. 


AnswerWizard displays different types of topics in response to the user request:  “How Do I” topics and “Tell Me About” topics.  “How Do I” topics focus on coaching you through the process, while “Tell Me About” topics focus on teaching you about project management concepts that relate to the feature you have inquired about.  Some “How Do I” topics even provide Interactive Answers which actually take control of the interface and show you how to perform the steps required to complete your task.  There are over 150 Interactive Answers in Microsoft Project for Windows 95, which represent a clear advantage for new users who are trying project management software for the first time.


GanttChartWizard


Microsoft Project provides tools to make it easy for any user to format their Gantt Chart for professional-looking reports.  The GanttChartWizard interviews you about what you want your Gantt Chart to look like, and applies the formatting automatically.  This feature employs graphical previews to make it very easy to understand what your Gantt Chart will look like.  The Gantt Chart Wizard reduces the number of steps required to customize the look of your Gantt Chart to a few simple clicks of the mouse.


SureTrak 1.0 for Windows


Interface


SureTrak 1.0 has done a fine job copying the Microsoft Project basic interface.  SureTrak 1.0 includes toolbars, ToolTips, status bars, and context sensitive shortcut menus.  All features pioneered in Microsoft products.  Unfortunately this interface is only skin deep.  Underneath the main menus are a plethora of confusing menus and dialog boxes.  For example, in Microsoft Project to sort tasks by date you select Start date from the Tools/Sort menu.  To sort your activities in SureTrak you select Organize from the Format menu then you must change the sort order in the bottom corner of the dialog.  In research at Microsoft we found that Sorting a Project is a fairly common activity which is why we placed it on an easy to access menu.


Microsoft Project organizes details about a task in the Task Information dialog.  This dialog can easily be found by double clicking on the affected task.  In SureTrak 1.0 the information is stored in a  series of dialog boxes.  These dialogs can all be found under the Activity Detail in the Display menu.  They range from Codes to Updates and they are all very confusing.


 Direct Manipulation


Direct manipulation is one of the hallmarks of Microsoft Project.  At any time a user can drag and drop on the Gantt chart to draw in tasks, drag across a bar to input percent complete, drag and drop tasks to rearrange the order of the project. None of these can be done in SureTrak 1.0.  


In addition one of the most common user actions is to pick up a task and drag it to a new starting point.  In SureTrak 1.0 you cannot pick up a task.  You cannot even achieve the same affect by extending the duration then change the start of the task. SureTrak 1.0 does not change the constraint on the task and pops the task back to the beginning of the project.  To change the start date of a task you need to go into the activity form and click on the Cnstrnt button, check the “Start On” box then in the drop down pick a date.  You cannot even type in the table portion of the Gantt chart without changing default options.


Novice user assistance


Changing the way a Gantt chart looks is one of the fundamental functions a user accomplishes.  No default Gantt chart is exactly what all users want.  Much like Microsoft Project 1.0, SureTrak 1.0 has a very flexible Gantt chart.  You can make all sorts of changes and have all sorts of displays.  Unfortunately you need to circumvent the dialog box below to accomplish these changes:


�


Microsoft Project created a wizard to walk the user through this common process.  The wizard asks questions and provides feedback never making the user guess what they are going to get.  For example adding or removing a critical path is simplistic.


�


All software products become easy to use once you master them. Because Project Management software is used less frequently it must be easy to use after not being used for weeks.  For this reason Microsoft has invested thousands of dollars and hours in usability testing.  By finding out how users naturally interact with products Microsoft has been able to create products that lead the industry in ease of use.


Leadership


In selecting a project management package, it is important for users to feel confident that they have made the right choice.  Statistics such as market share, awards received, and customer testimonials can serve as compelling evidence for a product’s leadership in the category.  


Microsoft Project for Windows 95


Market Share


Microsoft Project is by far the world’s most popular project management software.  Since introducing the first Windows-based project management package in 1990, Microsoft has been chosen by more project managers than any other planning package in history.  In June of 1994 Microsoft announced the one millionth unit of Microsoft Project.  The most recent Dataquest figures estimate Microsoft Project’s market share at nearly 60%, and no other project management packaged had greater than 9% of the remaining share.  This is an incredibly strong indicator that more managers trust their project plans to Microsoft Project than to any other planning software program in the world.


Awards


Microsoft Project has won more industry awards than any other project management software.  Recent awards include:  


Software Digest, Highest Rated Product


BYTE, Readers’ Choice Award


PC Magazine, Editor’s Choice


Software Publishers Association, Best Vertical Application


Windows Magazine, Win 100


InfoWorld, Product of the Year


PC World, Best Buy





SureTrak 1.0 for Windows


New Product


SureTrak 1.0 for Windows is a new product to the mid range project management market.  SureTrak for DOS never reached 1% of the mid-range category.


Awards


As of this writing SureTrak 1.0 has not won any awards although they have recently been chosen as an  "A-List" product by PC Computing.


Product Family


One should not select a project management program without fully understanding its relationship to other software programs that are available.  Evaluations should consider how well the project management program will fit in with other common desktop tools, as well as the number and variety of add-on products that are available to meet more specialized customer needs.


Microsoft Project for Windows 95


Third-Party Solutions


Business solutions based on Microsoft Project are becoming increasingly popular.  There are over 100 software add-ins available for Microsoft Project, which offers everything from sophisticated charting to risk analysis to timesheeting and enterprise-wide project management systems.   A catalog of these third-party products is included in the Microsoft Project box, and an online guide to some of them is available via the Help menu in Microsoft Project.


Office Family


Microsoft Project is offered as an integral part of the Microsoft Office family of applications.  As a part of this family, Microsoft Project is tightly integrated with each of the Microsoft Office applications, including Microsoft Word, Microsoft Excel, Microsoft PowerPoint®, Microsoft Access, and Microsoft Schedule+.  No matter what type of tool you need to use to present your project plan, the close relationships between Microsoft Project and these other desktop applications will make it easy for you to share information in the format that makes sense for you.


Office Compatible


In addition to the Microsoft Office family of applications, Microsoft Project also shares the same look and feel as over 250 other “Office Compatible” applications.  These programs are non-Microsoft software programs that have been built to run and integrate well with the Microsoft Office program.  Programs such as drawing and accounting packages are available to complete your desktop of productivity applications.  By investing time in learning any of the Microsoft Office applications, you are learning the basics of virtually hundreds of other common desktop tools!


 SureTrak 1.0 for Windows


 P3


Clearly one of the biggest benefits to using SureTrak 1.0 is the tight integration with P3.  By saving out into P3’s proprietary format, SureTrak 1.0 can be a low cost solution in places that already use P3.  Unfortunately this leaves the user to determine when to use SureTrak 1.0 and when to pay $5,000 for P3.


To create PERT charts, a common activity, requires P3


To combine projects seamlessly requires P3.�


Custom reporting requires P3


Custom fields to store information about a task requires P3


Multiple baselines to compare to your project against requires P3  


Cross-Platform


Few organizations are 100%  standardized on a single computer platform.  Since project managers need to communicate and share information across their organization, it is important for their project management software to work on a variety of platforms. 


Microsoft Project for Windows 95


Microsoft Project is available on a wide variety of  platforms, and shares the same file formats across all of the following computer operating systems:


Microsoft Windows 95


Microsoft Windows NT™, version 3.51


Microsoft Windows 3.1


Microsoft Windows for Workgroups,


Macintosh


Power Mac


SureTrak 1.0 for Windows


 Platforms


SureTrak 1.0 only supports Windows 3.1.


Training and Support


As the project management category expands, it is becoming increasingly important for software vendors to provide customers with access to knowledgeable support staff  and training materials.  Additionally, it should be easy for customers to seek out other third-party training materials, books, and courses if they desire a deeper level of knowledge about their product.


Microsoft Project for Windows 95


Product Support


Microsoft Project has a dedicated support line with more trained technicians than any other project management support line.  Product Support is free, and is offered from 6am to 6pm Pacific Time, Monday through Friday.   Twenty-four hour, seven day a week support is offered as part of a support package that is available at an additional charge.


Online support forums are staffed by Microsoft Project experts on CompuServe and MSN™, The Microsoft Network.  Access to the Microsoft Project forum on The Microsoft Network is only a mouse-click away in the Help menu. - Select “The Microsoft Network” from the Help menu, and you will be logged in directly to the Microsoft Project support forum which is monitored by Microsoft support engineers. 


Training Centers


There are over 600 Training Centers around the United States which conduct Microsoft Project training, and have developed courseware and videos to help both new and experienced users get up and running with Microsoft Project quickly and easily.   Additionally, there are Microsoft Project Solution Provider Consultants all over the country who name Microsoft Project training as one of their specialties.   No matter where you live or work, training and support on Microsoft Project is available via classroom seminars, video presentations, or self-study materials.


Third Party Reference Books


In addition to the training course materials that are available, there are several third-party reference books you can find in your local bookstore or software center.  Some of the titles Microsoft Project customers have found useful include:


Microsoft Project for Windows Step by Step, Microsoft Press, 1994.


PC Learning Labs Teaches Microsoft Project 4.0 for Windows, Ziff-Davis Press, by Kulik and Wilcox, 1994.


Using Microsoft Project 4 for Windows, QUE Corporation, by Tim Pyron, 1994.


Managing Projects with Microsoft Project,  ITP\VNR, by Gwen Lowery, 1994.


SureTrak 1.0 for Windows


Third Party Reference Books


As of this writing there are no books published for SureTrak 1.0 for Windows.


Training and Support policy


SureTrak has toll support from 6am to 6pm MST Monday - Friday and 8am to 2pm MST on Saturday.  Many Primavera authorized training centers also train on SureTrak 1.0.  In addition Primavera supplies a BBS to download frequently asked questions and other related information.


Conclusion


Microsoft Project is a fourth generation project manager whose focus has always been on users new to project management. SureTrak 1.0 for Windows is low end project manager designed by high end designers. Compared to Microsoft Project, SureTrak does not have the required ease of use nor the feature set to address the fundamental needs of a project manager.  SureTrak’s key advantage seems to be the ability to write data to Primavera’s P3, thus increasing the use of P3 in a business.


�
Appendix


If you are still unsure of the usability of SureTrak 1.0, take the below Usability test.  This test is very similar to the tests Microsoft conducts every day in our usability labs. 


Below are several extremely common actions for any project manager and can be accomplished by both Microsoft Project and SureTrak 1.0.  Give a new user Microsoft Project and SureTrak 1.0 and ask them to complete the following  tasks.  


Create four tasks with 4,3,2 and 1 day durations


Link the first two tasks


Set task 3 to start a week from today


Set task 4 to start next week Monday


Sort the task by their start date


Insert a task at the beginning of the Project


Indent the four tasks below this task to create a summary task at the beginning.


Change the end points of the task bars to diamonds.  


Create a resource called Ed


Assign Ed to first two tasks


Filter to only show those tasks Ed is working on























For further information about Microsoft Project please contact your local sales office or call 1-800-426-9400.    
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� Software Digest, volume 12 number 1


� You can combine Projects in SureTrak but you must define the project as a sub project on creation and you must store the file as a P3 file and adhere to P3’s four character name limitation.  
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